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1 Introduction

Today's customer demands more flexibility and customization possibilities than
“physical configurations” can offer. With new Philips configurable devices with built-in
controls or separate controllers you can configure the luminaire’s behavior. You can
control output levels, or even pre-configure dynamic dimming on the client’s request;
either directly in the factory or during installation on location. All you need is ONE
intuitive tool that when plugged into a device can calibrate ALL the different
functions required by any lighting solution.

Creating the perfect lighting solution has been made very easy with Philips MultiOne.

With MultiOne, you can configure all features that are supported by a Philips device.
A feature typically belongs to one or two product groups (LED Indoor/Outdoor, HID
or FLUO), but this does not mean that every device from a product group does
support all features.

Philips MultiOne is supported by Windows XP + SP3, Windows 7, Windows 8 and 8.1
operating systems. It works only in combination with the Philips LCN8600 MultiOne
interface USB2DALI, with Philips LCN8650 MultiOne interface USB2ZigBee, Philips
LCN9600, LCN9610 or LCN9620 MultiOne interface SimpleSet®.
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3  System requirements

The minimum system requirements for using MultiOne are:

PC or laptop with Microsoft Windows XP SP3, Windows 7, Windows 8 or 8.1
- USB 2.0 ports:
o Two free USB 2.0 ports for use with USB2DALI interface
o One free USB 2.0 port for use with USB2ZigBee interface
o One free USB 2.0 port for use with SimpleSet® interface
- Ethernet port:
o One free Ethernet port for use with Art-Net protocol
- At least 35 MB of free disk space
- Microsoft .NET Framework 3.5 SP1 (download here for offline installation)



http://www.microsoft.com/en-us/download/details.aspx?id=5007

4 Downloading and installing MultiOne and the
documentation package

A zip-file can be downloaded from www.philips.com/MultiOne. This zip-file contains
the following files:

e Philips MultiOne.exe (executable/installer)

e Philips MultiOne Workflow.exe (executable/installer)
e GettingStarted.pdf (document)

e UserManual.pdf (document)

e RELEASE_NOTES.txt (document)

The MultiOne installation file is the installer for the full version of MultiOne. This
document applies to this version of the software.

The MultiOne Workflow installation file is the version of MultiOne which is meant to
be used in a production environment.

Note! Make sure a User Software Key is present before installing. If you wish to
install without a User Software Key, installation is possible, but you cannot work
with MultiOne.

To install the software, launch the installer for the desired version and follow the
instructions on your screen.
The installation wizard will guide you through the process of installing the software

and will ask you where the software needs to be installed. At the end, it will give you
the option to immediately start MultiOne.


http://www.philips.com/MultiOne

5 Attention points

5.1 General

Before starting MultiOne, make sure that the correct interface (USB2DAL],
USB2ZigBee or SimpleSet®) has been connected to your computer.

When upgrading the Windows Operating System, make sure the connection settings
are correct when using MultiOne again.

When starting multiple instances of MultiOne for parallel configuring, make sure
every instance of MultiOne uses another interface. The unique id of an interface is
shown in the Connection Settings window where the interface port is selected. Also,
for the currently selected interface the unique id can be found in the About box and
in the tooltip of the connection status indicator in the statusbar at the bottom-right
part of MultiOne.

5.2 DALI

Lighting applications with DALI devices can be seriously affected by the
presence/absence of the DALI short address. Make sure the DALI short address is as
you expect, after finishing working with MultiOne.

5.3 SimpleSet® interface

For SimpleSet® there are three interfaces which can be used for communication (see
§6.3): the Philips LCN9600, LCN9610 or LCN9620 MultiOne interface SimpleSet®.



6 The MultiOne interfaces

6.1 DALI

The Philips LCN8600 MultiOne interface USB2DALI (USB2DALI interface) is the
interface between the PC and the DALI devices. It has a mini- USB input connector
and two parallel DALI output connectors. The USB2DALI interface status is indicated
by three LED's located near the mini-USB connector.

The USB2DALI interface is supplied with a USB cable that can supply the DALI
network with up to 220mA. It is advised to only use the supplied cable, in order to
assure correct functioning of the USB2DALI interface.

e Safety: Class II, double insulated
e DALI open circuit voltage (when power supply enabled): 15V

mini-USB input connector

PHILIPS

DALI PC Too! USB Interface
LCNB600/00 OA- B
S - — DA+
b 9137003 467 S
@ | ™ Madein The Netherlands NGH =@
(Ve 0.5..1.5C D El
o 2209 +|
S (== |

MM g e 5

Status LEDs: Double DALI
e DALI power supply enabled output
e DALI active connector
e Power
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6.2 ZigBee

The Philips LCN8650 MultiOne interface USB2ZigBee (USB2ZigBee interface) is an
USB dongle which interfaces between the PC and the ZigBee devices.

6.3 SimpleSet®

The Philips LCN9600, LCN9610 and LCN9620 MultiOne interface SimpleSet® are USB
devices which interface between the PC and the SimpleSet® devices:

Philips LCN9600

(O

S

e

Z

W

L

Philips LCN9610 Philips LCN9620
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7  Starting MultiOne

Before starting MultiOne, make sure that the correct interface (USB2DALI,
USB2ZigBee or SimpleSet®) has been connected to your computer.

7.1 Activating MultiOne

When starting MultiOne for the first time, the first window that appears is the
MultiOne user software key information. Here you can activate your copy of
MultiOne with your own user software key.

Note! MultiOne must be connected to the internet upon first usage in order to
activate.
rI.I-I MultiCne user software key information E

Activation status:  Not activated

Key =tatus: Not activated

Activate...

User software key details: Supported features:

Use the Activate... button to continue activation.

Use the Help button to show the User Manual.



Select Activate MultiOne online now and follow the instructions.
© |

\ng %%,Thrboﬂrﬁvate

Activate MultiOne now

Your activation period has expired and MultiOne is no longer working. To use your software
you must activate this copy of MultiOne.

2 Activate MultiOne online now

= Buy a new product key online

=% Retype your product key

2 Other options...

What is activation?
Read the privacy statement online

Cancel

b

The other items on this window are less relevant. For completeness:

Select Buy a new product key online brings you to www.philips.com/MultiOne.

Actually buying keys online is not supported.

Once you have activated MultiOne with a user software key, you can select Retype
your product key to switch to a different user software key.

The other items shown on the dialog are not supported.

If all goes well the activation is successful and the MultiOne user software key
information screen should show the correct details and supported features
corresponding to the user software key.

13


http://www.philips.com/MultiOne

B MultiOne user software key information “

Activation status: Activated

Key status: 0K
User software key details: Supported features:
Profile | Engineering 1-10V min dim level .i
Key |wess e ane o ssmp o e Actilume =)
12NC |913700362103 Active Cooling
Adjustable Light Output
Adjustable Qutput Cur...

S TS = — =

MultiOne is now ready for use!

Note! Not all functionality described in this document applies to all MultiOne user
software keys. For instance, some device features might not be available, or they
might only be partially configurable.

7.2 Application mode selector

Once the activation process is done and when starting MultiOne, the first window
that appears is the Application Mode Selector. Here, you can choose an application
mode, based on the tasks you would like to perform. The application window also has
links to the documentation.

PHILIPS

Application mode Recent documents

All

Commands

Features

k]
®
. Query
"
w

Diagnostics

Scheduler

Single device programming
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One of the modes is Single device programming. This mode simplifies some parts
of the device configuration workflow when only one device has been connected.
Single device programming is discussed in detail in chapter 12.6.

If you know that you will mostly perform the same tasks in the future, you can select
Remember my choice and then click the appropriate application mode. MultiOne
will record your choice and The Application Mode Selector will not appear again the
next time MultiOne is started.

You can always go back to the Application Mode Selector by selecting View >
Application Mode Selector from the main application window.

15



8 Selecting the interface

After the Application Mode Selector you must select the interface (USB2DALI,
USB2ZigBee, Ethernet or SimpleSet®) to work with.

8.1 Interface Auto detection

Interface can be automatically detected in case of DALI and SimpleSet®.

On first start MultiOne will detect whether DALI or SimpleSet® interfaces are
connected to your PC or laptop.

e When only one interface is connected this one will be automatically chosen.
e Otherwise the Connection Settings window will appear.

Whenever MultiOne is started again and a previously selected interface is not
connected anymore the following selection or action will take place:

e When only one interface is connected (independent of the type of interface)
this one will be automatically chosen.

e When two interfaces are connected and one of them is of the same type as the
previously selected interface this interface is automatically selected.

e Otherwise the Connection Settings window will appear.

Connecting multiple similar SimpleSet® interfaces is currently only supported when
using a FEIG interface.

Notice! Whenever MultiOne is started again, if the previously selected interface is not
either Dali or SimpleSet® the auto detection will not work and MultiOne will start with
the previously selected interface.

8.2 Interface Manual selection

First select the protocol: DALI, ZigBee, Art-Net or SimpleSet®, when needed also
indicate the selected interface and port or reader (in case of SimpleSet®).

16



Connection settings @
® DALLI O ZigBee O Art-Net O SimpleSet
Interface selection
Selected interface MuttiOne DALl interface -
Selected port 17A717294007 -
| e ]

This protocol can always be changed later, by going to the Tools > Connection
settings.

Notice! For DALI and SimpleSet® the unique id of the interface is shown at the
port/reader selection. This, to be able to identify which interface is used by which
MultiOne instance (when configuring devices in parallel using multiple instances of
MultiOne).

When a selected interface contains an outdated firmware version, MultiOne will show
a message that it is unable to connect to the selected interface:

Connection settings @

O DALLI O ZigBee

O Art-Net  ® SimpleSet

Unable to connect

MultiOne can't connect to the selected interface because its firmware version
(02.03.00) is outdated.

| ==
8.2.1 Art-Net

For the Art-Net protocol the delay time between sending frames is shown in the
dialog. This delay time is set to 28ms and cannot be changed.

Selected interface [AtNet (10.45.67.2) -]

RDM delay time (ms) 28 =

17



Note! Please make sure that the selected interface corresponds to the connected Art-
Net network and has the correct IP address (for example use the 10.45.67.2 interface
to connect with a Luminex network).

18



9 Working with the Philips LCN8600 MultiOne interface
USB2DALI

Before using MultiOne with the USB2DALI interface make sure that all devices that
need to be commissioned are connected to the mains and the DALI network. Finally

the DALI network must be connected to one of the DALI connectors of the USB2DALI
interface.

9.1 The main application window

If in the Application Mode Selector screen All is selected as application mode, the
program will start as follows:

DRV LTl Comman..  Traceability  Scheduler  Query  Diagnostics

No device has been selected or the selected device doesn't support any features.

Use Network to select a device.

Scan network

Properties 1 x| Legging

A more thorough explanation on how to communicate with devices can be found in
chapters 12.2,12.11, 12.12, 12.12 and 12.3 of this manual.

9.2 Managing the DALI network

The Network panel is used to manage the connected DALI network. A number of
tasks can be performed in the Network, each of which is detailed below.

9.2.1 Identifying devices

When starting MultiOne, the DALI devices connected to the USB2DALI interface are
not automatically identified. There are two methods for identifying the devices with
corresponding buttons in the Network on the left-hand side of the application
window: Scan network and Commission.

19



Metworl .

MNetwork Gnqn

I All devices
‘... User-defined groups

Scan network Commission

9.2.1.1 Scan network
There are two ways to scan a network: by short address or by random address. You
can choose which method to use by going to Tools->Preferences->DALI scanning.

The key differences between scanning by short address and scanning by random
address are the following:

e Scanning by short address will not change the random addresses of the
connected devices. You should use this method if random addresses should
not be affected. Additional user input might be required to find all connected
devices (see below).

e Scanning by random address will change the random addresses of all
connected devices. Any devices that don't have a short address yet will be
assigned one automatically. Any devices that share the same short address will
be automatically assigned (new) unique short addresses. This method is most
likely to find all connected devices without user intervention.

Scan by short address. This method queries all short addresses without changing
anything in the configurations of the connected devices. If all connected devices have
a unique short address, this method will be able to find all devices. If, however, some
devices share the same short address, or if there are devices without a short address
(uncommissioned devices), additional decisions need to be made.

The following situations can occur while scanning a network by short address:

e There are uncommissioned devices. You will see the following dialog:

ez sevce: D &

Once or more uncommissioned devices were found. Do you want to commission
these devices?

Warning: by clicking yes, the random address of all devices in the network will be
changed.

T
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By clicking Yes, the uncommissioned devices will be commissioned. As a side
effect, the random addresses of all connected devices will be changed.

By clicking No, no additional actions will be done and the Network will not
display all devices.

There are devices with the same short address. You will see the following
dialog:

Duptcne ot e IR 5

Multiple devices were found that share the same short address. Do you want to
recommission these devices?

Warning: by clicking yes, the random address of all devices in the network will be
changed.

By clicking Yes, the devices that have the same short address will be
recommissioned. As a side effect, the random addresses of all connected
devices will be changed.

By clicking No, no additional actions will be done and the Network will not
display all devices. Errors are likely to occur, indicated by a warning icon next
to the name of the device(s).

There are uncommissioned devices AND devices with the same short address.
You will see the following dialog:

" Uncommissioned devices and duplicate short addresses @

The following situation occurred:

- One or more uncommissioned devices were found.
- Multiple devices were found that share the same short address.

How do you want to continue? Click cancel to accept the network in
its current state.

O Commission the uncommissioned devices and recommission the
devices that share the same short address

O Commission the uncommissioned devices only

Warning: by clicking continue, the random addresses of all devices

in the network will be changed.

By choosing the first option, all uncommissioned devices will be
commissioned, and all devices with the same short address will be
recommissioned. By choosing the second option, only the uncommissioned
devices will be recommissioned. By clicking Cancel, no additional actions will
be done and the Network will not display all devices. Errors are likely to occur,
indicated by a warning icon next to the name of the device(s).

21



Scan by random address. This method re-initializes the random addresses of all
connected devices. If there are any uncommissioned devices, or devices that have the
same short address, these devices will automatically be (re)commissioned.

9.2.1.2 Commissioning

All devices are given a new unique short address, starting at 0. Be aware that existing
short addresses are erased and new short addresses are re-assigned to all connected
devices. This procedure ensures that all devices have a short address and that there
are no duplicate short addresses.

After commissioning or scanning the network, the list of identified devices is shown in
the Network.

9.2.2 Selecting devices for communication

After having commissioned or scanned the network, the Network shows all devices
present in the DALI network.

Network

- All devices

0: Xitanium Outdoor 40W. 7P+ VO1ED

© b1 Xitamium 36V 0.3-1A 54V TD 230V 1.3
‘... User-defined groups

Scan network Commission

By clicking a device you will make that particular device the active one, meaning that
all commands will be sent to this device only, and will be ignored by all other devices.
Besides selecting a single device for communication, it is also possible to
communicate with groups of devices. The options are:

e All devices in the network. Select All devices. All commands will now be sent

as broadcast commands. Note that unidentified but connected DALI devices
will also respond to commands.
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e All user-defined groups. Select User-defined groups. All commands will now
be sent to devices that belong to a user-defined group. User defined groups
are explained in the section 9.2.3.

e A specific user-defined group. Expand User-defined groups and select the
desired user-defined group. All commands will now be sent to devices that
belong to this specific user-defined group.

9.2.3 Managing user-defined groups

Using the Network, devices can temporarily be grouped into user-defined groups.
The purpose of user-defined groups is that they facilitate easy clustering so that a
number of devices can be addressed simultaneously.

The user-defined groups are lost when MultiOne is closed.

A new user-defined group can be created by right-clicking User-defined groups and
selecting Add new group.

- Al devices

5---dd new group "

Alternatively choose Actions - Add user-defined group. A new group is created
with a default name. To add a device to a user-defined group, right-click the device,
select Add to custom group and select one of the available user-defined groups.
Alternatively, the device can be dragged onto the desired user-defined group to add
it to that group.

To immediately add a device to a new user-defined group, right-click a device and
select Add to user-defined group and select Add new group.

Netwaork:

= All devices

I O: itanium 17W 0.3-1A 24V TD/Is 2 3

‘... User-defined groups Identify
| Add to user-defined group  » Add new group

Set short address...

Reset short address

The user-defined group will be created and the selected device will be added to the
newly created user-defined group.

To rename a user-defined group, right-click the group and select Rename. This will
set the user-defined group to edit mode so that the new name can be entered.

23



' Network 1 x
Metwork [RE[LTL

-~ Al devices
- User-defined groups

Remaove

| Rename

To remove a device from a user-defined group, right-click the device in the group
and select Remove.

To remove an entire user-defined group (including its devices), right-click the group
and select Remove.

Metwork a1 x
Metwork  [E[TE

- All devices
= User-defined groups

My oo

Note! The number of devices in a user-defined group is limited to 64.

9.2.4 Managing groups

Once all the devices in the DALI network are commissioned, i.e. have a unique short
address, it is possible to work with DALI groups.

Select the Groups tab and press Scan groups. After having scanned the network for
groups, the Groups tab shows all the DALI groups and the found devices for every

group.
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Network o x

II::' Groups

=% Un-grouped devices
... 0 ¥itanium Outdoor 40W 7P+ VO1ED1
= Group 0
o 1: Xitanium 36W 0.3-1A 54V TD 230V 1.3
.. Group 1
.. Group 2
..Group 3
.. Group 4
.. Group &
... Group &
... Group 7
.. Group 8
.. Group 9
.. Group 10
.. Group 11
.. Group 12
.. Group 13
.. Group 14
.. Group 15

Scan groups

DALI groups are much more comprehensive than user-defined groups. The important
difference is that with DALI grouping information is stored in the devices themselves.
Therefore, DALI grouping is more permanent than user-defined grouping.

By clicking on a device you will make that particular device the active one, meaning
that all actions will be performed on this device only, and will be ignored by all other
devices.

The options are:

e With a right-click on an un-grouped device you can:
o Identify the device
o Add to, add the device to one group
o Configure..., add device to multiple groups

Device configuration @

Selected groups for device LED
925000712803:

»

® Group 0 il
® Group 1
O Group 2
O Group 3
O Group 4
O Group 5
[ Group & | 4
O Group 7

[ Group 8

| [ Group & |

[ Groun 10
=

m
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e With a right-click on a device in a group you can:

.

Identify the device

Add to, add the device to one other group

Configure..., add/remove device to/from multiple groups
Remove, remove device from current group

o O O O

Device features

Ii:ﬂ' Groups
(=)~ Un-grouped devices - Dynadimm
L1 Xtenium 25W 031436 ||| | Summary v
= Group 0 Dynadimmer Enabled:
i L.D: Dynavision Prog R2.2 .
; Time bas¢
(=) Group 1 cLo
witch Mid point
- Group 2 Identify : -
© L.0: Dynavision P selection Time
- Group 3 i Dim 00:00
i l.0: Dynavision Configure.. TR
Group 4 Remowve .
- Group 5 — F ¥y Meter
Scan groups ALD

Besides selecting a single device for communication, it is also possible to
communicate with a group of devices.

The options are:

e With a right-click on a group you can:
o Identify the devices in the group
o Configure..., add/remove multiple devices to/from the group
o Clear group, remove the devices from the group

26



MNetwork q x
Groups

Un-grouped devices -

Identify

Configure...

Clear group

Scan groups

Note! The number of devices in a DALI group is limited to 64.



10 Working with the Philips LCN8650 MultiOne interface
USB2ZigBee

10.1 The main application window

If in the Application Mode Selector screen All is selected as application mode, the
program will start as follows:

Mo device has been selected or the selected device doesn't support any features.

Use Network to select a device.

B Scan area to find devices

Connect to network

10.2 Connecting to a ZigBee network

The Network panel is used to manage a connected ZigBee network. A number of
tasks can be performed in the Network panel, each of which is detailed below.

Network 1 x
Network
= Network: D7BF13BD5CTEE1CD

10.2.1Identifying devices
The ZigBee devices and networks in the area of the USB2ZigBee interface are not

automatically known.



To find devices and networks in the area press Connect to network: MultiOne scans
for an open network in the area and connects to the network. After connecting has
finished, the network and the found devices are shown in the Network panel.

10.2.2 Selecting devices for communication

After having connected to the network, the Network panel shows all devices and the
network to which MultiOne is connected. By clicking on a device or network you will
make that particular device or network the active one, meaning that all actions will be
performed on this device or network only, and will be ignored by all other devices or
networks.

With a right click on a device you can:
o Identify the device

10.3 Advanced commissioning

To commission a ZigBee network, right click the Network panel and choose Enable
advanced commissioning.

Network  |SZ0rES]
Use Network t

| Enable advanced commissicning

The Network panel switches to a different view making it possible to manage ZigBee
networks.

10.3.11dentifying devices

Press Scan area to scan for all the devices and network in the area of the USB2ZigBee
interface. After scan has finished the devices and networks in range of the interface
are shown in the Network panel.

10.3.2 Managing networks
The options are:

e With a right-click on an unassigned device you can:
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o Add to, move the device to an existing network or move the device to a
new network
e With a right-click on a device in a network you can:
o Add to, move the device to an existing network or move the device to a
new network
o Reset, from network, the device will become unassigned. If the network
becomes empty, the network will be removed
e With a right-click on a network you can:
o Query network, to find all devices in the network, including the devices
that are out of range of the USB2ZigBee interface
o Open network, to add more devices

10.3.3 Managing zones

Once you have scanned the area and found devices and networks in range, it is
possible to scan a specific network for zones. Select the Zones tab, select the
Network and press Scan zones. After having scanned the network, the Zones tab
shows the found devices and zones within the specified network.

[ [
Network: 98640 11C2A3FDOCE -
[
124B0 5 Actiume v1.0
Zone SOFC
124B0001D: 9 Actiume v1.0
124B0001DEEE18: Acthume v1.0

By clicking on a device or zone you will make that particular device or zone the active
one, meaning that all actions will be performed on this device or zone only, and will
be ignored by all other devices.

e With a right-click on an unassigned device you can:
o Identify the device
o Add to, move the device to an existing or new zone
e With a right-click on a device in a zone you can:
o Identify the device
o Add to, move the device to an another or new zone
o Configure..., move the device to another zone
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Device configuration @

Selected zones for device Actilume:

® Zone 2100
O Zone E196

o | o |

o Remove, the device will become unassigned. If the zone becomes
empty, the zone will be removed

e With a right-click on a zone you can:
o Identify the zone
o Configure..., add/remove multiple devices to/from the zone. If other
zones become empty, they will be removed

Zone 2100 El

Select devices for Zone 2100:

[® 124B0001D8EG2B: Actilume v1.0
[® 124B0001079342: Actilume v1.0

1

o Remove zone, the zone will be removed and the devices will become
unassigned



11 Working with the Philips LCN9600, LCN9610 or
LCN9620 MultiOne interface SimpleSet®

11.1 The main application window

If in the Application Mode Selector screen All is selected as application mode, the
program will start as follows:

No device has been =elected or the =elected device doesn't support any features.

Use Network to select a device.

[ No device detected

Logging
Timestamp Description

Scan for device

11.2 Scanning a SimpleSet® device

The Network panel is used to manage the scanned SimpleSet® devices. A number of
tasks can be performed in the Network panel, each of which is detailed below.

11.2.1Identifying devices

The SimpleSet® device near the SimpleSet® interface is not automatically known by
MultiOne. To get the device press Scan for device: a pop-up will appear indicating
the device must touch the interface.

Touch and hold the device close to the SimpleSet® interface until the scan has
completed. The scanned device will be shown in the Network panel.
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11.2.2 Auto read
After a device gets selected all features are shown on the Features tab and auto rea

d

gets activated. Auto read automatically start reading the configuration of all features.

Progress is shown as described in chapter 12.2

11.3 Selecting devices for communication

After having scanned the SimpleSet® device, the Network panel shows the device. By
clicking on a device you will make that particular device the active one, meaning that

all actions will be performed on this device only, and will be ignored by all other
devices.

11.4 Starting communication

In order to communicate with a SimpleSet® device, the device has to touch the
SimpleSet® interface. Before starting the communication MultiOne will show a pop-
up when the device is not near the SimpleSet® interface. This pop-up waits until the
device and the SimpleSet® interface touch, or disappears after 20 seconds. After
touching the action will be executed. Touch and hold the device close to the
SimpleSet® interface until all communication has finished.

Please touch...

Waiting for the device
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12 Working with MultiOne

12.1 Viewing device properties

Whenever a device is selected in Network, the Properties display a number of

details for the selected device.

Selected Xtanium 40W 1.1A B4V DALI SR INT
Version 0.1

12MC 929000724613

Device type LED

Firmware revision 1082

Device identifier ED0258D265175078

12.2 Communicating with a device

Initiating communication with a device is done by first selecting the device (left-click
the device in Network) and then clicking Read, Write or Reset on the toolbar.

File  Actiznc View Tools Help

'oRead @ wiite @ Reset ]. -
e —————

When the Commands tab or the Scheduler tab is active, these buttons are
unavailable. When the Query tab is active, all queries are executed when clicking
Read. When the Diagnostics tab is active, all diagnostics information is read (if
available in the selected device) when clicking Read. When the Device features tab is
active, the Read and Write actions are available. The Reset action is only available on
the Device features tab when the selected device has 1 or more features that are
resettable. The Reset action will set a feature to its factory defaults.

Reading, writing and resetting will always take a few seconds. Operation progress is
shown on the status bar of the main application window. On the Device features tab,
per-feature progress is shown on each of the feature selection tabs. When all
information has been successfully read or written, a green tick mark will appear and
the text Status: OK is shown. If anything goes wrong, a red icon and the text Status:
failed is shown. When on the Device features tab, point your mouse to each status
icon to see a more detailed description of the communication result.

Apart from using Read and Write on the toolbar, you can directly send DALI
commands. This can be done on the Commands tab and the Scheduler tab.
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In the Preferences window it is possible to enable extra verification when writing (see
chapter 12.18).

12.3 Configuring device features

You can configure all features that are supported by a specific Philips device. For any
device selected in the Network, the Device features tab displays the set of device
features that corresponds to this device. Upon selecting another device, the Device
features tab will be updated as well. This mechanism ensures that only the features
supported by the selected device can be configured.

The Device features tab has a panel with a column of tabs on the left-hand side.
Each feature has its own tab. For most devices a Summary tab is available as well.

AmpDim
Summa
4 [ Enable
Dynadimmer
Values
CLO 100
Li . Low % 60
n
Low V 195 80
Lamp selection
: High % 100 80
AmpDim
High v 230 70
ALOD
&0
Energy Meter

50

Light level (%)

40

30

20

i0

70 90 110 130 150 1v0 150 210 230 250 270

Mains (V)

To make sure that the feature information in the Device features tab corresponds to
the selected device, click Read on the toolbar.

View Tools

(@ Read P Write @ Reset | =

File  Actions Help
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Note that some features might be OEM Readout-protected. OEM Readout-protected
features are indicated by a padlock icon in the Read feature configuration window.

Read feature configuration @

Please indicate which feature configurations need to be read.

Features

% (De)select all

% DALI Power Supply

% Adjustable Output Current
% & Energy Meter

B Indicates that the feature is OEM Readout-protected.

If an OEM Readout-protected feature is read, a dialog will appear asking for an access
level and a password.

' Enter password @

Access level: D

Password: | | | | | | | |

. T

After providing a correct access level and password, and clicking OK, the OEM
Readout-protected features will be read. By clicking Cancel none of the selected
features will be read. If an incorrect access level and/or password were provided, the
OEM Readout-protected features will receive a status icon indicating failure (see
below).

To make sure that the feature information is stored in the selected device, click Write
on the toolbar. If you want to reset certain features to its default settings, click Reset
on the toolbar. Be aware that you need to click the Read button afterwards to reload
the reset values.

Note also that some features might be OEM Write-protected. OEM Write-protected

features are also indicated by a padlock icon in the Write feature configuration
window.
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‘Write feature configuration @ ‘Write feature configuration @

Flease indicate which feature configurations need to be written. Flease indicate which feature configurations need to be written.
Features Features
% (De)select all (De)select all
% DALL Power Supply DAL Power Supply
% Adjustable Light Output Adjustable Light Output
® @ OWP settings (ALO Min) @ OWP settings (ALO Min)
® @ Adjustable Output Current @ adjustable Output Current
¥ Energy Meter Energy Meter
® @ OEM Write Protection ® @ OEM Write Protection
The device already has an OWP password @ Indicates that the feature is OEM Write-protected.

) i When clicking Write, the following actions will be performed:
@ Indicates that the feature can be OEM Write-protected.

- Write feature configuration

When clicking Write, the following actions will be performed: - Verify feature configuration

- Write feature configuration You can adjust this behavior in the preferences.

- Verify feature configuration

You can adjust this behavior in the preferences.

Also note that you must check a check box to indicate that the device already has an
OWP password configured. MultiOne does not know this, because the configuration
of a device is not always read before a Write action takes place. When the check box
is checked and the Write button is clicked, a dialog will appear asking for a password.
When the OWP configuration was already read, MultiOne knows the current OWP
configuration and the check box will not be shown. In that way, MultiOne will show
the password dialog only in case if OWP is enabled in the device and a write
protected feature is selected.

Enter current password @

Password: I:I I:I I:I I:I

After providing a correct password and clicking OK, the OEM Write-protected
features will be written. By clicking Cancel none of the selected features will be
written. If an incorrect password was provided, the OEM Write-protected features will
receive a status icon indicating failure (see below).

For Read, Write and Reset actions, status icons will be shown when a feature is being
read or written. There are three different colors used for the icons: red, green and

grey.

Red means that the reading or writing has failed. The green icon indicates that the
reading was successful and that all the data was sent to the driver. This does not
mean that all data is actually received (see Write and Verify in chapter 21). The grey
icon is used to display that the read or write action is pending for the specific feature.
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Summary

) Dynadimmer
() cLo

© LineSwitch
© Lampselec...
o AmpDim

(%) ALO

(1) Energy Meter

Read

Summary

@) Dynadimmer
@ cLo

@) LineSwitch
O Lampselec...
o AmpDim

(V) ALO

(¥) Energy Meter

Write

General

-:::- Mode 1
-:::- Mode 2
-:::- Mode 3
@ Mode 4
@® Modes
@ Mode 6
CJ Mode 7

Reset

In the following sections you will find an overview of all supported device features in
alphabetical order. Features typically belong to one or two product groups (LED, HID

or FLUQ), but this does not mean that every device belonging to a certain product
group will automatically support all of its features listed here. For an overview of

supported device features see Supported features.

12.3.11-10V

Product group

LED

%] Enahle

Curve selection:

1-8V linear

Description
Use this feature to set the minimum dim level when using 1-10V.

Usage

e Use the slider or the text field to select a value. The value represents the light

level.

e Use the dropdown box to select the wanted curve selection (1-8V linear, 1-9V

linear, 1-10V curved or 1-8V logarithmic). The curve selection is device

dependent.
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12.3.2 ActiLume General

Product group/family

CONTROL/ActiLume DALI

Configuration:

Mode:

IR channel:

Region:

Occupancy sharing:

* Local daylight sensing
[* Local presence sensing

Fresence sensor sensitiviby:

Night mode
Hold time:

Background level:

Prolong time:

BMS

Light =en=zor reference point:

[J DALI occupancy reporting

| Parallel link

[1

A

|EU

[Mode based

| High

600 [

[5 minutes

[20%

[15 minutes

O Send HYAC/sunblind messages to BMS

Description

Use this feature to configure general ActiLume settings.

Usage

Use the various drop down boxes, check boxes and text fields to make a

configuration.

Please refer to the ActiLume DALI gen2 Application Guide for further details.
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Product group/family
CONTROL/ActiLume Wireless

Mode: [‘] vl
IR channel: [H vl
Region:

[0 100 hour burn-in

Light =ensor reference point:

= m
L=l )| [y
=
o
&

I3
Reference point correction factor: 8
Occupancy mode override: [F‘ath of egress 'l
Description

Use this feature to configure general ActiLume settings.

Usage
Use the various drop down boxes, check boxes and text fields to make a
configuration.

Please refer to the ActiLume Wireless Application Guide for further details.

12.3.3 ActiLume Mode
Product group/family
CONTROL/ActiLume DALI

m}
Daylight dependent switching: = ]
Daylight dependent regulation: = [
Switch on level prior to DDR: % % 100 % 100 % 100 %

Mode based linking

Daylight regulation offset:

Reaction to mode: 1 [Ignore v] 5 [Ignore v] 9 [Ignore v] 13 [Ignore v]
2 [Ignore v] = [Ignore v] 10 [Ignore v] 14 [Ignore v]
3 [lgnore v 7 [ignore +] 11 [ignore +] 15 [ignore -
4 [ignore +] 8 [ianor ~| 12 [ignore x| 16 [ignore -]

Group based linking

Base group: Local occupancy -
Secondary group: Local occupancy -

Hold time: 15 half min
Prolong time: l:l min O Infinite
Smart time: min
Grace time: s ¥ Fade during grace period
Light status on power up:
Retention time: 15 »| min
Background level: %
Dwell time: I:I s
Light sensor reference point: 210 3
Group 1 Group 2 Group 3 Group 4 Group 5
Cccupancy mode: [Mo on / auto off v] [Mo on / auto off v] [Mo on / auto off v] [N.rto on / auto off v] [Mo on / auto off -
Daylight dependent override: [x] O m] [m]
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Description
Use this feature to configure ActiLume settings that apply to the system’s modes. For

ActiLume DALI gen2, up to 16 modes are shown, each of which has its own feature
tab on the left-hand side. Use the ActiLume Mode feature to configure settings for
each individual mode.

Usage
Use the various drop down boxes, check boxes and text fields to make a

configuration. Click the Reset to factory defaults button to reset the current mode
to the factory defaults.

Please refer to the ActiLume DALI gen2 Application Guide for further details.

Product group/family
CONTROL/ActiLume Wireless

Held time: |3D | half min
Prolong time: |El | min Infinite
Light status on power up: [Ugl‘rts off 'J
Background level: |1El | a
Occupancy mode: [Pa_rto on / auto off YJ
Light sensor reference point: |21D | Ix
Description

Use this feature to configure ActiLume settings for that apply to the system’s modes.
For ActiLume Wireless, up to 32 modes are shown, each of which has its own feature
tab on the left-hand side. Use the ActiLume Mode feature to configure settings for
each individual mode.

Usage
Use the various drop down boxes, check boxes and text fields to make a

configuration.

Please refer to the ActiLume Wireless Application Guide for further details.
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12.3.4 ActiLume Scene
Product group/family
CONTROL/ActiLume DALI

Group 1 Group 2 Group 3 Group 4 Group 5

Dim behavior:  |Manual dim level - Manual dim level - Manual dim level = Manual dim level Manual dim level -

Dim level: [so | = |[s0 | = [s0 | = [s0 | = [s0 | =

Description

Use this feature to configure ActiLume settings that apply to the system'’s scenes. For
ActiLume DALI gen2, 5 scenes are shown, each of which has its own feature tab on
the left-hand side. Use the ActiLume Scene feature to configure settings for each
individual scene.

Usage
Use the various check boxes and text fields to make a configuration.

Please refer to the ActiLume DALI gen2 Application Guide for further details.

12.3.5 Active Cooling

Product group
LED

Values

Fan level (%)

0 10 20 30 40 50 60 70 80 Eln) 100 110 120 130 140

Temperature (2C)

150

Description
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Use this feature to control the fan of the LED module and minimize audible noise
from the active cooling unit. The driver increases the fan output level (and so the
speed of the fan) when temperature of the LED module becomes too high. When the
fan output level increases the temperature of the LED module should be reduced.

The customer can specify the temperature limits to make sure the fan output level is
kept as low as possible and will only increase when needed so the audible noise is
reduced.

Usage
Drag the points or the lines in the resulting graph to adjust the configuration.
Alternatively, use the table to enter values directly.

Note! For a detailed technical description of the characteristics of the device model,
like constraints and limitations, please refer to Device-specific technical description.

12.3.6 Adjustable Light Output

Product group
HID
% Enable
ALO: i [ ] ) %
ALO min: (] [ ] ] Ya
Description

Use the Adjustable Light Output (ALO) feature to regulate the light output to a
desired optimum value. You can create a “virtual lamp” with output different than
what the standard wattages offer.

Usage

Select the Enable check box to use this feature. Use the slider or the text field to
select an ALO value. The value represents the light level. The ALO min value (not
available for all devices) can be used to set the lowest possible ALO value.
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12.3.7 Adjustable Output Current

Product group
LED

% External Rset

( [ ] ) [e50 més
Description

Use this Adjustable Output Current (AOC) feature to adjust the output current to a
desired optimum value. You can create a “virtual lamp” with output different than
what the standard wattages offer.

Usage
The current can be set in two ways:

o Select the External Rset check box: Adjustment of the output current is not
configured using MultiOne, but the value of an external resistor adjusts the
output current

OR

e Use the slider or the text field to select a value. The value represents the

nominal output current

12.3.8 Adjustable Startup Time

Product group
LED

L ] )] I'IUDU T
Description

At power on, the fast fade-up of light can be unpleasant in certain applications. To
avoid such a situation, the device fade-up time at startup can be adjusted.

Usage

Use the slider or the text field to select a value. The value represents the start fade-up

time in milliseconds.
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12.3.9 AmpDim

Product group

HID, LED

[® Enable

Values

100

Low % 60
Low V 195 50
High % 100 80
High v 230 70

60

50

Light level (%)

40

30

20

10

70 90 110 130 150 170 150 210 230 250 270

Mains (V)

Description
Use this feature to adjust the light output of a lamp by adjusting the mains voltage of
the device.

Usage

Select the Enable* check box to use this feature (note that LED devices do not have
this check box). Drag the points or the lines in the graph to create the desired
configuration. Alternatively, use the table to directly enter values.

Note! For a detailed technical description of the characteristics of the device model,
like constraints and limitations, please refer to Device-specific technical description.

* Note! If the device supports interface selection then this feature can only be
enabled through the interface selection and the enable will not be shown here.

12.3.10 Constant Light Output
Product group
HID, LED

12.3.10.1 HID version

The HID version of Constant Light Output (CLO) has two check boxes. Select the
Enable check box to use the device’s built-in Constant Light Output profile. Select the
Reset check box to reset this feature, including resetting the lamp operating hours
parameters. This is useful when replacing the HID lamp.
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12.3.10.2 LED version
The Constant Light Output feature for LED devices will show the following window:

[* Enahle
Schedule
-1
Working| Power K=
hours level
1] 40
#
7500 40 —
o
15000 |41 &
[ .
22500 42 g
(=]
30000 |44 e
37500 46 -
45000 49
52500 53
60000 57
0 5 1015202530354045505560657075560559095100031015
67500 61 )
& Working hours x1000 ¢h)
Description

The lumen output of a LED module usually decreases over its lifetime. To
compensate, a schedule can be created that gradually increases the lamp’s power
level over time.

Usage

Select the Enable check box to use this feature. Click the New button to create a
default schedule or click the Plus button to individually add scenes.

When creating a new schedule, in the dialog window that pops up you can either
select an empty schedule, a default schedule or a custom schedule.
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New CLO schedule... = New CLO schedule... B =

Custom CLO schedule How does this wor?

@ Empty schedule

Maximum working hours 120 x1.000

Number of scenes 16 =
() Default schedule
Initial power level 40 %

Final power level 100

(7) Custom schedule...

When selecting a custom schedule, you have to enter a number of parameters that
will define the CLO schedule. These are:

e Maximum working hours: the largest number of working hours for which the
CLO schedule is defined. This corresponds to the maximum value of the
horizontal axis in the resulting CLO graph.

¢ Number of scenes: the number of scenes (bars in the graph) into which the
total number of burning hours is divided

o Initial power level: the power level that is the starting point at 0 burning

hours
¢ Final power level: the power level at the end of the defined lifetime (the value

given for maximum number of burning hours)

After clicking Finish a CLO schedule will be created using linear interpolation of the
provided values.

Drag the points or the lines in the resulting graph to adjust the configuration.
Alternatively, use the table to enter values directly. Single or multiple table rows can
be removed by clicking the Minus button.

Note! The reliable use of Constant Light Output requires extensive LED specification
assessment of life time behavior of LEDs.

12.3.10.3 LED version (simplified)
The simplified Constant Light Output feature will show the following window:

%] Enable

Maximum working _
hours: ( L] ) 64000 h
Initial power level: ( [ ] i %
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Description
The lumen output of a LED module usually decreases over its lifetime. To

compensate, a schedule can be created that gradually increases the lamp’s power
level over time. By configuring the Maximum working hours and the Initial power
level a linear schedule is defined which consists of 16 scenes. The first scene starts at
Oh and at the specified initial power level. The last scene starts at the specified
working hours and at 100% power level.

Usage
Select the Enable check box to use this feature. Use the Maximum working hours

slider to configure the moment in time where the LED module will use the final power
level.

Use the Initial power level slider to configure at which power level the LED module
will initially start.

Note! The reliable use of Constant Light Output requires extensive LED specification
assessment of life time behavior of LEDs.

12.3.11 Correlated Color Temperature
Product group

LED

cCT: (4000 - k
Description

The CCT value is the actual Correlated Color Temperature value of a Luminaire
device. In this way, the user can configure the requested light color of the Luminaire's
LED module.

Usage

Select the CCT value from the dropdown box to change the Correlated Color
Temperature. This value is represented in Kelvin.
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12.3.12 Corridor Mode
Product group
FLUO, LED

% Enable

Dim level (%)

Mormal level: [ » |254 (2 100 %)
Background I— - 5
e s [ ] 3 170 (= 10 %)
Delay time: [ ] )] ID H
Fade time: [ [ ] ] |12 (32 5)
Prolong tirme: ( [ ] )] I1SDD s Infinite
Activation l—
time: C L S S5 =
. .
Description

Corridor Mode feature depends on Touch and Dim feature. The Corridor Mode
feature adjusts the light to a defined level when a presence sensor detects a person.
Corridor Mode can only be activated when the device is in Touch and Dim mode.

Usage
Select the Enable check box to use this feature. It is not possible to activate the driver
via Touch and Dim, when this check box is not checked.

This feature has the following parameters:

e Normal level: Light level to be set when presence sensor detects activity

e Background level: Low light level to be set when no presence is detected
after the fade time

e Delay time: The time from the moment the sensor has switched off and the
moment the device will start to fade to background level

e Fade time: The time used to fade from normal level to background level

¢ Prolong time: When reaching background level, the time after which the
device will be switched off

e Activation time: The time during which a mains signal must be detected,
before the device will switch to Corridor Mode
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Alternatively to using the sliders, some lines and points in the graph can be dragged
to adjust the configuration.

12.3.13 DALI Power Supply
Product group
LED

‘ [® Enable ‘

Description
Use the DALI Power Supply (DALI PSU) feature to enable the device so it will deliver
the power supply for DALI communication by itself.

Usage
Select the Enable check box to use this feature.

12.3.14 Device Info
Product group
LED

Drevice model:

Device label:

LED reference bin code:

LED colour code:

| |
| |
Date/Order code: | |
| |
| |
| |

LED bin code:

Description
Use the Device Info feature to get or set the device information which may be
luminaire specific.

Usage
Select the Device Info feature tab to read or write the device information.

12.3.15 Dimming Interface
Product group
LED
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Dimming curve
Interface DaLl j g _
® Logarithmic
Linear
Description

Use the Dimming Interface feature to select the dimming interface for the device. The
actual options are depending on the device model:

e 1-10V

e DALI

e Dynadimmer
e No dimming
e AmpDim

¢ LineSwitch

When DALI has been selected, an additional setting appears with which the dimming
behavior can be set. Options are Logarithmic and Linear dimming curves.

Usage
Use Dimming Interface to select the desired dimming interface.

Product group
FLUO, LED

Interface IAutomatic selection j

Description
Use the Dimming Interface feature to select the dimming interface for the device.

Usage

Thezvailable dimming interfaces are stored in the device and therefore need to be
read out. When the interfaces are found it will be possible to select Automatic
selection (enable all interfaces), No dimming (disable all interfaces) or a single
interface.

Product group
LED

Can be overridden by
Interface Dynadimmer -

LineSwitch
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Description
Use the Dimming Interface feature to enable dimming interfaces for the device.

Usage
The available dimming interfaces are stored in the device and therefore need to be

read out. When the interfaces are found it will be possible to select and enable the
main interface. Some interfaces have the possibility to be overridden by another
interface. If that's the case the Can be overridden by part will show the other
possible interfaces that can be enabled together with the main dimming interface.

Note! Once a Can be overridden by interface was selected, the main selected
dimming interface still needs its override option to be set accordingly. This can be
done by going to the specific interface feature and enable the override option there.

12.3.16 Driver addressing

Product group
LED

DMX address:

# Enable

Group size: |2 '|

Group address: |'I v|

Description
Use the Driver addressing feature to determine the DMX settings for the device.

Usage
e DMX address: DMX address

e Enable: When the check box is cleared the grouping feature within one DMX
address is not used.

e Group size: Number of devices that operate within one group, all responding
to the same DMX address.

e Group address: Device number within the group of devices that respond to
the same address.
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12.3.17 Dynadimmer
Product group
HID, LED

% Enable

= )
Time based i
a0 _ :

Midnight shift
minutes: B

Schedule
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2 :u 80
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Tirme: 07:00
] " I

23:00

Time

(hh:m

Light Fade S0
level time

(%) (s)
80 180

40
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02:00
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09:00
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Time (h)

Description
Use Dynadimmer to create a dynamic dimming schedule over a period of time.

Usage
Select the Enable* check box to use this feature. This feature has a number of

options, depending on the device model:

Time based: switch between absolute and relative time schedules. When the
Time based check box is cleared, the Dynadimmer schedule will use its
automatically learned midnight point as a reference for timekeeping. When the
Time based check box is selected, the reference point is the moment when
the mains are switched on. Selecting the Time based check box changes the
graph and removes its dotted midnight line. Note that not all devices support
Time based Dynadimmer.

Midnight shift: the midnight point depends on the geographical location.
Enter the midnight shift in minutes or use the midnight shift calculation
window to automatically adjust the midnight point by the specified offset. Use
the calculation button to either manually provide latitude and longitude
coordinates or to choose a predefined location. The midnight shift option is
unavailable when the Time based check box has been selected.

The midnight shift calculation dialog window looks as follows:
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Calculate midnight shift =

® From location

Location Albaria 2

From coordinates
Latitude 0 deg |0 min |0
Longitude 0 deg |0 min |0

Time zone

Calculated midnight shift (min): 0

I I

_— = —

¢ Location: a name that identifies this custom location.

e Latitude: the latitude of the location in degrees, minutes and seconds. The
value that represents the degrees cannot be negative.

e N-S: the direction for latitude of the location. The user can either select North
or South value.

e Longitude: the longitude of the location in degrees, minutes and seconds. The
value that represents the degrees cannot be negative.

e E-W: the direction for longitude of the location. The user can either select East
or West value.

e Time zone: the time zone of the location. For GMT+1 enter 1, for GMT-1 enter
-1, and so on.

o Daylight saving: indication whether daylight saving should be dealt with or
not.

You have two choices for calculation of midnight shift. If your location is available in
the location list you can use it. Some locations are not listed. For those unlisted
locations use the geographical coordinates to calculate the correct midnight shift.

Click OK to save result of your calculation as the new midnight shift. Note that
clicking OK is not directly saving your data to the driver. To save midnight shift to a
driver you will have to write the whole feature. Note also that the location is not
written into the driver, the midnight shift is written instead.

Click the New button to create a default schedule or click the Plus button to add
scenes individually. Drag the points or the lines in the graph to create the desired
configuration. Alternatively, use the table to enter values directly. Remove single or
multiple table rows by clicking the Minus button.

Note! The device will follow the dimming schedule. When the light level in the
dimming schedule is below the physical min level of the selected lamp, the physical
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min level will be used. However, some devices are also capable to switch off during
the dimming schedule, if a scene was configured at 0 %.
The physical min level of the selected lamp is indicated by the gray-dotted line in the

graph.

* Note! If the device supports interface selection then this feature can only be
enabled through the interface selection and the enable will not be shown here.

12.3.17.1 Physical min level

In order to see the correct physical min level of a lamp after Lamp Selection do not
forget to switch the driver off for a few seconds. After switching it on again the
selected lamp is activated. To see the physical min level of the selected lamp in the
graph, click Read on the toolbar.

12.3.17.2 Location or custom location

For some device models, only the midnight point offset is stored in the device and
NOT the (custom) location. In those cases the location information and the custom
location is only used to calculate the midnight point offset. After reading out the
device, MultiOne tries to match the midnight point offset with a location. In case the
midnight point offset does not match to a location or the midnight point offset
matches multiple locations, MultiOne will show “No location”.

For a technical description of the characteristics of the device model, like constraints
and limitations, please refer to Device-specific technical description.

12.3.18 DC Emergency
Product group
FLUO, LED

% Enable

allow dimming

Ernergency level:

( & [ (= 70°%

Description

This feature is used together with a DC central battery system. The device will dim to
a specific level, as soon as a DC voltage is detected at the mains input instead of an
AC voltage on the mains input of the device. The dimming of the lamps can either be
enabled or disabled during this DC Emergency operation.

Usage
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Select the Enable check box to use this feature. Use the slider or the text field to
select a value. The value represents the arc power level when in DC Emergency mode
(the label on the right gives the approximate light level percentage). Select the Allow
dimming check box to allow dimming when in DC Emergency mode.

12.3.19 End Of Life indication
Product group
LED

% Enahble

L ] )ID h

Description

Use this feature to warn the user at the end of the guaranteed lifespan of the LED
module. Once the end of guaranteed life is reached, the device will flash the lamp for
5 seconds and then continue normal operation. LED flashing will happen every time
at startup once the device's working hours have exceeded the number of hours
specified as End Of Life. This feature uses the same burning hours counter as the
Light Source Operating Hours and Constant Light Output features.

Usage
Select the Enable check box to use this feature. Use the slider or the text field to
select a value. The value represents the guaranteed lifetime in hours.

12.3.20 Energy Meter
Product group
FLUO, HID

Reset meter

Energy consumed: 1,3 kwh
Total energy consumed: 1,3 kwh

Actual power consumption: 48 W

Description
Use this feature to get an indication of the (total) energy consumption of the device.

Usage

The value for Energy consumed can be reset by selecting the Reset meter check box
followed by clicking Write on the toolbar. The value for Total energy consumed
cannot be reset. The Actual power consumption is the power currently being used.
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12.3.21 Lamp Burn-in

Product group
FLUO
% Enable
Burn-in level : Use default
r [ ] y [e50 (=90 %)
Burn-in time: Use default
[ [ ] )] IBEIEIEI ity
Description

Lamp Burn-in prevents dimming below a predefined level in the first hours of a
lamp’s life. This is to ensure that the lamp will be properly “burned in” before
dimming.

Usage

Select the Enable check box to use this feature. This feature has of two parameters:

e Burn-in level: use the slider or the text field to select a value. The value
represents the maximum arc power level for dimming (the label on the right
gives the approximate light level in percent). Alternatively, select the Use
default check box to use the default value.

e Burn-in time: use the slider or the text field to select a value. The value
represents the time in minutes during which the burn-in level is active.
Alternatively, select the Use default check box to use the default value.

12.3.22 Lamp Selection

Product group
HID, FLUO

Selection IHID Cosmopolis 454 j
Description

Use the Lamp Selection feature to select the lamp type that is connected to the
device. Options depend on the device model.

Usage

Use Selection to select the lamp type. Note that this feature has to be read first in
order for the options to become available. To read the feature configuration, click
Read on the toolbar.
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Note! After selecting a different lamp, it is necessary to switch the driver off for a few
seconds. After switching is on again the selected lamp is activated.

12.3.23 Light Source Operating Hours
Product group
LED

[ ] JID h

Description

Use this feature to manually set or reset the number of operating hours for the LED
module. This is useful when replacing the LED module, thereby resetting features like
Constant Light Output and End Of Life indication.

Usage
Use the slider or the text field to select a value. The value represents the number of
operating hours.

12.3.24 LineSwitch

Product group
HID, LED
Enable
High  level: | S ()
Low V lewel: & v 50
Fade on time: | J—
Satteh off ! ——
delay time:
Fade off time: | I
MNote 1: Low V = 0 W on the mains; High vV = 208-277 V on the mains.
Mote 2: When Dynadimmer is scheduled, LineSwitch can not be used
standalone. It can only be used to override Dynadimmer.
Description

This feature provides an interface for easy dimming via pilot-line or external sensor
(presence) of a group of lamps. Dimming to desired level can be controlled by
applying a 230V between the DALI inputs. The fade times can also be set using the
fade on-, fade off and switch off delay time.
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Usage
Select the Enable* check box to use this feature. This feature has the following
parameters:

e High V level: Use the slider or the text field to select a value. The value
represents the light level to be set when high voltage is detected on the mains.

e Low V level: Use the slider or the text field to select a value. The value
represents light level to be set when low voltage is detected on the mains.

e Fade on time: Use the slider or the text field to select a value. The value
represents the fade on time to be used.

e Switch off delay time: Use the slider or the text field to select a value. The
value represents the switch off delay time to be used.

o Fade off time: Use the slider or the text field to select a value. The value
represents the fade off time to be used.

* Note! If the device supports interface selection then this feature can only be
enabled through the interface selection and the enable will not be shown here.

12.3.25 Lumen Level

Product group
LED
¥ Luminaire efficiency correction enabled
Light ocutput ratio (LOR): 4 [ J U
Lumen output: [ ] b Im
Description

This feature provides an interface for setting the lumen output value of a device.

Usage

Check the Luminaire efficiency correction enabled check box to use the Light
output ratio (LOR) slider. This slider is used to configure the range and step size of
the Lumen output slider.

The Light output ratio percentage will change the Lumen output slider min range,
max range, current value and step size by the same percentage.
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12.3.26 LumiStep
Product group
LED

* Enable
Dim period: 6 Tl h

Dim level: ] 31

Description
This feature provides a simplified version of Dynadimmer.

Usage
Select the Enable* check box to use this feature. This feature has the following
parameters:

e Dim period: Use the drop down box to select the wanted dim period. This is
the time period the dim level will be used.

e Dim level: Use the slider or the text field to select a value. The value
represents the dim level in percent. The dim level will be used during the dim
period.

* Note! If the device supports interface selection then this feature can only be
enabled through the interface selection and the enable will not be shown here.

12.3.27 Min Dim Level
Product group
LED

* Enable

Description
This feature provides an interface for setting the min dim level of a device.

Usage
Select the Enable check box to use this feature. Use the slider or the text field to
select a value. The value represents the min dim level in percentage.
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12.3.28
Product group
LED

Module Temperature Protection

® Enable

100

30
a0
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Dim level (%)
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Temperature (°C)

D) 100 110 120 130

140

e B2sec/m): R(25°C):

Startdim: ¢ T [ ] ) 2967 Q =70°C)

Stop dim: ¢ [ ] T ) 2536 Q (=75°T)

Dim level: ¢ [ ] 3 10
Description

Use this feature to regulate lamp power when the LED module gets too hot. At a
certain temperature the lamp starts to dim in order to control temperature. At a
critical temperature level the lamp will switch off completely.

Usage

Select the Enable check box to use this feature. Drag the points or the lines in the
resulting graph to adjust the configuration. Alternatively, use the sliders to changes
values directly. Based on the device model, the feature is shown in either temperature
(degrees Celsius) or resistance values (in Ohm).

Note! For a detailed technical description of the characteristics of the device model,
like constraints and limitations, please refer to Device-specific technical description.

12.3.29 OEM Write Protection
Product group
LED

Set the OEM Write Protection password

[ Enable
New password: EI El EI EI
Werify password: EI El EI EI

The password must contain 4 numbers (0-255).
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Description

OEM Write Protection (OWP) defines a password that will be set in the driver so the
data of OEM Write-protected features can only be written to the driver by providing
the configured password.

Usage

When the Enabled check box is selected, a password needs to be entered. This
password must contain 4 numbers between 0 and 255. Passwords containing 0-0-0-0
and 255-255-255-255 are not allowed. The password needs to be verified before it
can be stored in the driver. Once a password is configured into the device, it is
necessary to provide the current password when writing other features that are OEM
Write-protected. These features are indicated by a padlock icon @ in the Write
screen.

When the OWP feature is read, only the value of the enabled check box is shown on-
screen, so it is not possible to retreive the currently configured password.

12.3.30 Quick Lamp Start
Product group
FLUO

% Enable

Description

When the Enable check box is selected, the lamp can be switched on immediately
without the necessity for preheating the lamp. The preheat sequence (typically
between 0.6 seconds and 1.0 seconds) will thus be skipped. This is possible because
heating of the electrodes is not turned off.

Usage
Select the Enable check box to use this feature.

12.3.31 Touch and Dim

Product group
FLUO, LED
Use last known level
Power on level: ( [ ] )] (=1 %)

Ignore toggle limits
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Description
This feature defines the startup behavior of a touch and dim controlled device after a
power failure during dimming.

Usage

When the Use last known level check box is selected, the device will start up at the
last known dim level that was used during dimming.

If this is not checked the power on level can be configured between 0 and 100% of
the light.

When the Ignore toggle limits check box is selected, the normal toggle limits are
ignored and dimming starts directly.
If this is not checked the normal toggle limits are used.

12.4 Using the features summary

For most devices an additional tab is shown on the Device features tab, called
Summary. The Summary tab gives a compact overview of the settings that have
been entered for all the features of this device. As the features are different per
product group, the summary is also different. The features cannot be changed on the
Summary tab.

Lamp selection

Selected: HID CDoO 250
Dynadimmer AmpDim

Enabled: Tes Enabled: Mo

TimeBased: Mo

Mid point shift: 0 min

Time [ Level | Fade Low percentage 60

WIHTE L L Low woltage 195

WSHE e G High percentage 100
High voltage 230

ALOD CLO LineSwitch
Enabled: Mo Ernabled: Mo Enabled: Ma
Qutput: 100 % High vaoltage lewvel: 100 %
Low voltage level: 50 %

Disabled features
- CLO

- LineSwitch

- Amplim

- ALO
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12.5 Saving and opening a feature configuration file

To save and open a feature configuration file, the Device features tab must be active.

Feature configurations can be saved to a file for later use. To do so, first select the
Device features tab to make feature configurations for the selected device. Then,
click the disk icon on the toolbar or select File > Save as.

File  Actions View Tools Help

@ Read @ Write @ Reset ..; =

A dialog window pops up that lists the features of the device:

Save feature configuration @

Please indicate which feature configurations need to be sawved.

Features

[ (De)select all

O Touch and Dim

[ Adjustable Output Current

[0 Module Temperature Protection
[0 Constant Light Qutput

O Corridor Mode

[0 Energy Meter

[0 DCEmergency

[® Include device information in the saved file
(Xitanium 36W 0.12-0.4A 110V TD 230V 1.4)

m

Select any number of features and click Save. The save file dialog window appears.
Choose a location and a file name and click Save. The selected features will now be
written to the file.

It is also possible to save the device information alongside the features. This data can
later be used in MultiOne Workflow to ensure the configuration can only be

configured in the saved device model.

As mentioned before, some features can be OEM Write-protected. These features will
be marked with a padlock icon in the dialog.
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Save feature configuration @

Flease indicate which feature configurations need to be saved.

Features

% (De)select all

® @ Adjustable Output Current
¥ @ Constant Light Output

® @ OEM Write Protection

The device already has an OWP password
* Include device information in the saved file
(OWP device 1.0)

B Indicates that the feature can be OEM Write-protected.

In this case it is possible to save the current password alongside the features, so
MultiOne Workflow can use this password to be able to write the data of the features
that are OEM Write-protected to the driver.

When using SimpleSet, MultiOne compares the provided password with the password
in the device before writing the new data. When there is a mismatch, an error
message will be shown.

Password failure @

The provided password was not correct.

To open a feature configuration file, click the folder icon on the toolbar or select File
- Open. The open file dialog window appears. Select a file and click Open.

File  Actions View Tools Help

@ Read @ Write @ Re et |-' 13

The contents of the Device features tab are updated to show the information that
was read from the file.

Only feature configurations are stored in the file. This means that a file made for a
certain device can be read into the Device features tab for a different device.
MultiOne attempts to read as many feature configurations as possible.

Example: a feature configuration file exists that was made for device D1, which has
features AOC, CLO and MTP. A different device, D2, has features AOC, Energy Meter
and Touch and Dim. When opening the feature configuration file for device D1 while
device D2 is selected, only the configuration for feature AOC will be read, since
features CLO and MTP are not supported by device D2.
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Feature configuration files can be distributed to other users of MultiOne. A typical
example is that one user prepares a feature configuration file, and then sends it to
another user who uses MultiOne Basic. This user then opens the file and configures
the connected device.

12.6 Configuring a single device

There are situations in which only one device will be configured at the time. In this
case it is not necessary to have the full functionality of the Network, including Scan
and Commission buttons. To optimize the workflow for single device configuration,
select Single device programming in the Application Mode Selector.

When Single device programming has been selected, MultiOne will automatically
scan the DALI network and select the connected device for communication. In this
mode, the Network panel is collapsed by default. If multiple devices have been
found, MultiOne will show a message and switch to regular configuring mode.

12.7 Configuring multiple DALI devices (simultaneously)

There are situations in which multiple devices need to be configured at the same
time. The procedure to simultaneously configure multiple devices of the SAME TYPE
AND VERSION is as follows (Note! this method will not work with MultiOne Basic):

1. Connect maximum 64 devices of the SAME TYPE AND VERSION, in parallel to
the DALI connectors of the USB2DALI interface

2. Connect the USB2DALI interface to the USB port (both black and red USB

plugs (USB-A)).

Connect the devices to the mains.

Start MultiOne

Choose Tools = Preferences

Clear the Write & verify check box and click OK

Click the Commission button on the Network panel to start commissioning.

Choose Actions > Add virtual device.

Select the device of the same type and version as the ones connected on the

Network panel.

10. Select the Device features tab

11. Change any of the features.

12. Click Write on the toolbar.

© NV kW

Note! There will not be an individual confirmation for every device. So if any of them
failed to be configured, it is not known which one.
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Note! Remember that applications can be affected by the availability of the short
address.

12.8 Configuring multiple DALI devices (consecutively)

There are situations in which multiple devices need to be configured one after
another. The procedure to consecutively configure multiple devices of the SAME TYPE
AND VERSION differs slightly between MultiOne Basic and MultiOne (full version).

12.8.1 MultiOne Basic
1. Connect one device

2. Connect the USB2DALI interface to the USB port (both black and red USB
plugs (USB-A))

Connect the device to the mains

Start MultiOne

If needed, select All in the Application mode selector
Click Scan network in the Network panel to start scanning
Select File>Open to open the required feature configuration file

Select the Commands tab
At Data field, enter 255; click the Short Addr button. (See Note!)

This removes the short address; in the network the short address is shown as

©® N o U hkw

‘broadcast’

10. Select the Device features tab
11. Click Write on the toolbar

12. Replace device

13. Click Write on the toolbar
14. Replace device

15. Etc.

12.8.2 MultiOne (full version)
1. Connect one device

2. Connect the USB2DALI interface to the USB port (both black and red USB
plugs (USB-A))

Connect the device to the mains

Start MultiOne

If needed, select All in the Application mode selector

Click Scan network in the Network panel to start scanning

Select File>Open to open the required feature configuration file

Right click the device in the Network panel and select Reset short address

© ® NV AW

. Select the Device features tab
10. Click Write on the toolbar
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11. Replace device

12. Click Write on the toolbar
13. Replace device

14. Etc.

Note! Remember that applications can be affected by the removal of the short
address.

12.9 Configuring multiple ZigBee devices

There are situations in which multiple devices need to be configured one after
another. The procedure to configure multiple devices of the SAME TYPE AND
VERSION is described below.

Join multiple devices in a ZigBee network

Connect the USB2ZigBee interface to the USB port

Start MultiOne

If needed, select All in the Application mode selector

Click Connect to network in the Network panel to start scanning
Right click in the Network panel and select Add virtual device...
Select the device you want to configure and press OK

Configure the virtual device as desired

© 0 N o Uk~ wh

Select the virtual device in the Network panel and click Write to current
network... in the Actions menu

10. (De)select the features you want to write in the pop-up that appears and click
Write

Note! When devices of different types and/or versions are joined in the same
network, only the features that correspond to the features of the virtual device will be
configured. All other features will be ignored.

12.10 Offline feature configuration preparation

When a device or network is not present, it is still possible to prepare a feature
configuration. This might be useful when you would like to prepare a feature
configuration file that can be read at a later time, and written to the device when it is
connected. To make a configuration you need to add one or more virtual devices.

To add a virtual device, right-click All devices in the Network and choose Add

virtual device.
Alternatively choose Actions - Add virtual device.
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Network  [SUE LTS

Identify
Scan DALI network

Commission

L\ Add virtual device... |

A dialog window pops up that lists all devices supported by MultiOne.

Add virtual device @
Product group fiter [FLUO ']
Device [FLUO HF-Ri TD 1 14/21/24/33 TLS E+ 1.0 V]

=N

Make a selection and click OK. An item called Virtual devices appears in the
Network. Expand it by clicking the + sign to see the list of virtual devices. Note that
virtual devices do not have a short address and MultiOne will show Broadcast on the
location of the short address. Virtual devices can only be addressed using broadcast
commands.

Select a virtual device and select the Device features tab. The device features are
shown as if the device was physically connected. Configure the features as desired,
and then save the feature configuration to a file. You have now made a feature
configuration file without being connected a device.

12.11 Sending DALI commands

To manually send DALI commands select the Commands tab.

Device features ®TOTETS W Traceability  Scheduler  Query  Diagnostics
Light control

G P ]

]
]

Commander

Al ~| [DIRECT_ARC_POWERC v| Data: [0 |

*DALI Ed2 commands Result: [result]

Configuration commands

DTRO: D -= Max level Actual level -= DTRO
DTR1: EI -= Min level DTRO -> Fade time
DTRZ: EI -= System fail level | DTRO -= Fade rate

-= Power on level

The Commands tab has the following panes:
e Light control

e Commander
e Configuration commands
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Light control
This pane offers a number of buttons to immediately influence the behavior of the
device. These controls are useful when quick feedback in terms of light is desired.

Commander

To send a DALI command as a broadcast command, first select All devices in the
Network, then select the DALI command in the Commander pane and finally click
the Send button. To send a DALI command to a specific address or group, select the
corresponding device or group in the Network.

Note! DALI Ed2 commands are marked by an asterisk(*).

Configuration commands
To manually set or get the so-called DTR (Data Transfer Register) values of the device,
use the buttons in the left part of this pane.

To use the actual DTR value of the device with a number of DALI commands, use the
buttons in the right part of this pane. Besides a number of DALl commands using the
DTR value, also Reset, Step Up and Step Down are direct available.

12.12 Traceability

The Traceability tab summarizes how many times the configuration of the device was
changed, when the last configuration change happened using unknown software and
a pane showing details of the first, second and last configuration change (if present).

| | [Traceabiy | _Query_ I

Total number of configuration changes: 2

Most recent configuration change with unknown software: 1 operating hours

Date Software Interface

First 9/23/2014 3:07:00 PM MultiOne Wordlow 0.6 DALI

Second 9/26/2014 2:03:00 PM MuttiOne Wordlow 0.6 DALI

Every entry in the list shows the date of the configuration change, which software
version was used and which type of interface was used at the time of the
configuration change.

12.13 Working with DALI command scripts

To run a series of DALI commands, a script can be created in the Scheduler tab. This
script can be executed any number of times. Furthermore it is possible to save the
script to a file for easy reuse.
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Add item ltems Selected item

CMD Far count < 5

. Start time 212:58 PM
FOR OFF : data 0

S ® Delay (ms) 100

Device address(esz) |Selected device hd

Command OFF -

*DALI Ed2 commands
Clear All Data 0

The Scheduler tab has the following panes:

e Add item
o A CMD button to insert DALl commands
o A FOR button to insert a loop, consisting of a FOR and an END FOR

e Selected, containing buttons to work with (Up, Down, Delete, Clear All) the
currently selected item in the schedule

e Items, representing the schedule

e Selected item, the settings of the currently selected item

e Schedule playback buttons (Play, Pause, Stop)

To add a command to the schedule, click the CMD button. The command is added to
the schedule and it is automatically highlighted. On the Selected item pane, choose
the desired DALI command and settings. By selecting the Start time check box and
providing a time, this command will be sent at an exact moment in time.
Alternatively, commands can be sent relative to each other. Select the Delay check
box and provide a value in milliseconds to do so. At Device address you can select to
which device to send this command. You can choose between the currently selected
device, a broadcast or one of the 64 available short addresses (0-63). Then, select
which DALI command will be sent by using the two drop down boxes; the first selects
the command group and the second selects the actual command. If a command
parameter is required, enter it into the Data field.

Note! DALI Ed2 commands are marked by an asterix(*).
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By repeatedly clicking the CMD button, a series of DALI commands can be created.
Each command has its own settings.

A schedule can also contain loops. A loop has a FOR-item, one or more commands,
and finally an END FOR-item to mark the end of the loop. Click the FOR button to
create a loop. By default, the loop will run infinitely (that is, until schedule playback is
manually stopped or paused by clicking Stop or Pause). To change the number of
times the loop will be executed, select the FOR-item and enter a value for Maximum
count on the Selected item pane.

To rearrange the schedule, select a command and use the Up and Down buttons to
move this up or down respectively. Delete a command by clicking the Delete button.
To clear all the commands use Clear All button.

To start, pause, or stop a schedule playback, use the Play, Pause and Stop buttons.
To save a schedule to file for later use, click the disk icon on the toolbar. Alternatively,
select File > Save or File > Save As. Choose a location, a filename and click Save.

The schedule has now been saved.

To open a previously stored schedule, click the folder icon on the toolbar.

File  Actions View Tools Help
@ Read @ Write @ Resit |. )

Alternatively, select File > Open. Choose a schedule file and click Open. The
Scheduler tab now shows the schedule from the file.

12.14 Querying devices

To automatically execute a number of standard DALI query commands select the
Query tab.
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Device features ~ Comman.. Traceability  Scheduler JOTE8 Diagnostics

[0 Enable DALIEd 2

DALI Ed 1
Status 2 Max level 254 Scene level 0 255
Control gear present 255 Min level 85 Scene level 1 255
Lamp failure 255 Power on level 254 Scene level 2 255
Lamp power on o System failure 254 Scene level 3 255
Limit error 0 Fade time/rate 7 Scene level 4 255
Reset state 0 Groups 0 -7 2 Scene level 5 255
ersion number 8 Groups 8 - 15 0 Scene level 6 255
Extended version 0 Random address H 236 Scene level 7 255
Content DTR 0 45 Random address M 35 Scene level 8 255
Content DTR 1 51 Random address L 35 Scene level 9 255
Content DTR 2 0 Short address 0 Scene level 10 255
Device type 6 Missing short address |0 Scene level 11 255
Physical min as Power failure 0 Scene level 12 255
Actual level 255 Scene level 13 255
Scene level 14 255
Scene level 15 255

DALI Ed 2

To make sure that the information in the Query tab corresponds to the selected
device, click Read on the toolbar.

File  Actions Tools  Help
"o Read @ )Write (@ Reset |b -

View

12.15 Accessing diagnostics

Some devices from the product groups HID, LED and CONTROL support diagnostics.
To access these diagnostics, select a device in the Network and select the
Diagnostics tab. Upon clicking Read on the toolbar, the device’s diagnostics
information will be read and displayed. Note that some diagnostics might be OEM
Readout-protected and require a password before being able to read. Diagnostics for
a HID device might look as follows:
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Single values

System starts

System uptime (h)

Lamp uptime (1)

lgnition driver attempts

lgnition lamp attempts

Failures

Total energy consumed (Wh)

Energy consumed (resettable) (Wh)
24h reset expirations

Themal Guard protection

EOL driver incandescence failures
EOL lamp incandescence failures
EOQL driver arcing failures

EOL lamp arcing failures

EOL driver failure LED maodule voltage
EOL lamp failure LED module voltage

Driver ignition timeouts

Lamp ignition timeowts

8

Histograms
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Diriver temperature histogram (°C)

A brief explanation of all HID diagnostics is given below.

Table 1 HID diagnostics

Diagnostic

Description

System starts

System uptime (s)
Lamp uptime (s)

Ignition driver attempts
Ignition lamp attempts

Failures

Total energy consumed
Energy consumed
(resettable) (Wh)

24H reset expirations

Thermal Guard Protection

EOL driver incandescence
failures

EOL lamp incandescence
failures

Number of times the HID driver was switched on (via
the mains).
Total time the HID driver was on.

Total lamp burning time.

Number of times the HID driver attempted to ignite a
lamp.

Number of times the HID driver attempted to ignite
the lamp, since last lamp replacement 2.

Total number of failures detected by the HID driver.

Total energy consumed by the HID driver.

Energy consumed since last user-reset.

HID driver was operating for more than 24 hours; any
failures blocking driver to operate the lamp are cleared
Thermal Guard activated as a consequence of high
temperature level.

End-Of-Life situation showing incandescent mode of
operation of the lamp.

End-Of-Life situation showing incandescent mode of
operation of the lamp, since last lamp replacement 2.

74



EOL driver arcing failures
EOL lamp arcing failures
EOL driver failure lamp
voltage

EOL lamp failure Lamp

voltage

Driver ignition timeouts
Lamp ignition timeouts

Cycling driver failures
Cycling lamp failures
Extinguished failures
driver

Extinguished failures lamp
Mains high failures
Mains low failures

Bus failures

Vmid failures

Short circuits

ZCD failures

Over Power Protection

failures
Invalid lamp table failures

End-Of-Life situation showing an arcing mode of
operation of the lamp.

End-Of-Life situation showing an arcing mode of
operation of the lamp, since last lamp replacement .
End-Of-Life situation showing a lamp voltage level that
was out of operating range.

End-Of-Life situation showing a lamp voltage level that
was out of operating range, since last lamp
replacement 2.

Failed to successfully ignite the lamp.

Failed to successfully ignite the lamp, since last lamp
replacement 2.

Cycling of the lamp (extinguished for more than N
times subsequently) [where N depends on lamp type].
Cycling of the lamp (extinguished for more than N
times subsequently), since last lamp replacement
[where N depends on lamp type] .

Detection of an extinguished lamp.

Detection of an extinguished lamp, since last lamp
replacement 2.

Mains voltage level detected that was too high to
continue operation.

Mains voltage level detected that was too low to
continue operation.

Bus voltage level detected that was out of operating
range.

Midpoint voltage level detected that was out of
operating range.

Short circuit detected in the lamp connection.
Critical failure detected in lamp or driver.

Over power detected.

HID driver switched-on with a non-supported or
corrupt lamp table selected.

a) lamp replacement triggers an erase of predefined lamp-specific items such as ignition attempts, lamp errors.
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Diagnostics for a LED device might look as follows:

Single values Histograms

LED module voltage (V) 0 1000 o

LED module dim level (%) 100 200

LED module temperature (*C) Unavailable 500 wl]

Output cument (mA) 0 400

Driver temperature (*C) 28 200 &5
Maxdmum recorded driver temperature (C) 44 a

Minimum recorded driver temperature (1C) 23 21..36 =60
Maxdmum recorded LED module temperature (C)  Unavailable 0.-20 5760
Minimum recorded LED module temperature (T} Unavailable LED medule voltage (V)

System starts 66 1200

System on time (h) 156 1000

Module on time () 0 ﬁ 415

Mains overvoltage count 1476 iccz 0 0 0 0
Short circut False D I o oo
Open circuit False ﬁ "D‘: E E § §
Module NTC missing True - § § 5 g "
Madule light reduction active False ©
Module temperature too high Falze Output current (mA]

A brief explanation of all LED diagnostics is given below.

Table 2 LED diagnostics

Diagnostic

Description

LED module voltage (V)
LED module current (mA)
LED module dim level (%)

LED module temperature
(°C)

Driver temperature (°C)

System starts

Represents the output LED module voltage.
Represents the output LED module current
Represents the current dim level set by the LED
driver. Takes into account all factors that can
influence dimming like Constant Light Output,
Module Temperature Protection, all dimming
interfaces etc.

Represents the LED module temperature. Available
only when Module Temperature Protection is
selected and an NTC value is selected.

Represents the internal driver temperature. It does
not represent Tcase Of the driver. Though there is a
correlation between Tcase and internal driver
temperature, the difference can vary depending on
current setting of driver.

Represents the number of times the LED driver is
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System on time (h)

Module on time (h)

Module energy consumed

Short circuit

Open circuit

Module NTC missing

Module temperature
reduction active

Module temperature too
high

Mains too low

Adjustable Startup Time
active

powered ON.

Represents the hours the LED driver is ON. (LED
module is OFF)

Represents the number of hours the LED module is
powered ON.

Represents the energy consumed by LED module
alone. Only output parameters (LED module voltage
and current) are used to calculate energy. The LED
driver energy consumption is not accounted. Hence it
does not represent true input energy consumption
of the LED system.

This indicates if output LED module is shorted.

This indicates if output LED module is open or not
connected to LED driver

This indicates missing NTC on the LED module.
Available only when Module Temperature Protection
is selected and 10k NTC is selected. Missing NTC flag
will not be activated if 15k+390 Q NTC is selected.
This indicates light level reduction due to module
temperature being active.

This indicates whether the LED module temperature
exceeds 90 °C causing module to turn OFF.

This indicates that the LED driver is not operating
since input voltage at power ON is too low.

This indicates that the LED driver is in the startup phase as
defined by the Adjustable Startup Time. For example if the
Adjustable Startup Time is set to 20000 ms, and the
diagnostic information is read at startup within 20 s, this

check box will be selected indicating startup condition.

Some LED drivers only support a subset of diagnostics. It might look as follows:
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Single values

System on time (HH:MM) 02:43
Module on time (HH:MM) 02:43
System starts 730
Maximum recorded driver temperature (C) 50
Minimum recorded driver temperature (C) 13

Maximum recorded LED module temperature (C) 64
Minimum recorded LED module temperature (*C) 16

Mains overvoltage count 2

Table 3 Subset of LED diagnostics

Diagnostic Description

System starts Represents the number of times the LED driver is
powered ON.

System on time (h) Represents the hours the LED driver is ON. (LED
module is OFF).

Module on time (h) Represents the number of hours the LED module is
powered ON.

Maximum recorded driver = Maximum driver temperature ever reached during the

temperature (°C); lifetime of the driver.

Minimum recorded driver Minimum driver temperature ever reached during the

temperature (°C) lifetime of the driver.

Maximum recorded module Maximum module temperature ever reached during

temperature (°C) the lifetime of the driver.

Minimum recorded module Minimum module temperature ever reached during

temperature (°C) the lifetime of the driver.

Mains overvoltage count Number of times the mains exceeded the maximum

allowed mains voltage level.
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12.16 Art-Net export functionality

Art-Net has the possibility to export different features from multiple drivers to
extensible markup language (.xml) type of file for easy usage later on. The export
functionality is available under the Actions menu.

Actions
% Scan Art-Net network Ctrl+D

Export diagnostics...
Export all features...
Read from current device (group) Ctrl+R
Write to current device (group) Ctrl+W

Reset Device

The following two options are available to the user:

- Export diagnostics: Retrieve the diagnostic values from the selected device(s)
- Export all features: Retrieve all features from the selected device(s)

If the user selects either one of the options he will then be able to select the drivers
from which he would like to export the information from. The shown list contains all
available devices from the network, even the ones that do not support this
functionality, but the user will be unable to select the non-supported devices.

Selected devices

4 device(s) found

x|  UID Device name Supported
x| | 50:68:41:54:B0:33 LED HP 350W 1.10 1.16 Yes
% | 50:68:41:54:B0:34 LED HP 350W 1.10 1.16 Yes
% | 50:68:41:54:B0:35 LED HP 350W 1.10 1.16 Yes
x| | 50:68:41:54:B0:36 LED HP 350W 1.10 1.16 Yes

Once all needed devices are selected the user could start exporting the data.

Flease wait while exporting diagnostics...
Processing Device: 50:63:41:54:B0:33: LED HP 350W 1.10 1.16
Progress: 4 device(s) remaining

During the export the user will receive short updates on what device currently is
being processed and how many devices are still remaining.

Summary
Time: 0 hours 0 min & sec 501 ms
Result: 4 device(s) exported successfully
* = - = LED
R R MultiOne Diagnostics
Address Device Version Result Date version version mody
voltal
x| | 50:68:41:54:B0:33 |LED HP 350W 1.10 |1.16 0K 8/27/2015 12:07 PM | 2.10.0.0 o 0
x| | 50:68:41:54:B0:34 |LED HP 350W 1.10 |1.16 0K 8/27/2015 12:07 PM | 2.10.0.0 (1] 0
x| |50:68:41:54:B0:35 |LED HP 350W 1.10 (1.16 0K 8/27/2015 12:07 PM | 2.10.0.0 ] 0
x| | 50:68:41:54:B0:36 |LED HP 350W 1.10 |1.16 0K 8/27/2015 12:07 PM | 2.10.0.0 (1] 0
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Once the export is finished the user is then presented with the final result in a simple
overview. The user could make a selection of what devices it would like to save the
data from and save this to a supported file type.

12.17 The logging window

The logging window shows the communication related to the features currently
being read or written or when DALI commands are sent or received through the
USB2DALI interface.

29-3-201Z2 13:41:16 3 Constant Light Output: readin... |success
29-3-201Z2 13:41:16 3 Constant Light Output: readin... |success
29-3-2012 13:41:16 3 adjustable Light Sutput: readi... |success

0-7-20912 134114 Arnnhirm: readinn wvaliie iTarars]
Timestamp

The time the feature was read or written or the time the command was sent. The
format of the timestamp is: <date> <time>.

Address
The short address to which the feature or command was sent. In case Broadcast is
mentioned, all devices are addressed.

Description
The name of the feature or the actual DALI command.

Result
Result of the communication.

12.18 Setting preferences

MultiOne has a preferences window that allows you to customize the way MultiOne
works. To access the preferences window select Tools - Preferences.

Tools

Preferences. ..

Conneckion setkings. .

Paower supply L

[TTESIres"

The Preferences window that pops up allows you to set MultiOne preferences.
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12.18.1 General preferences

o 20200 W )

General preferences

General O Show application mode selector on startup
DALI scanning [ Scan network automatically on startup
Updates

O Play sounds when features are configured

[ Play sounds when features are read
[ Prevent sleep mode
B Write & verify

When write & verify is enabled an additicnal verification step will be
carried out after writing a feature configuration to a device.

Show connection settings [Never on startup -

Re-enable all warnings

The following list summarizes the available preferences and gives an explanation for
each.

¢ Show application mode selector on startup. When MultiOne is started you
are presented with a screen that allows you choose an application mode,
based on the tasks you would like to perform. You can disable this screen by
clearing the Show application mode selector on startup check box.
Changing this settings only takes effect one MultiOne is restarted.

e Scan network automatically on startup. By checking this check box
MultiOne will automatically initiate a network scan on startup. Changing this
settings only takes effect one MultiOne is restarted.

¢ Play sounds when features are configured. When this check box is checked,
MultiOne will make a sound when a feature configuration is (un)successfully
written to a driver.

e Play sounds when features are read. When this check box is checked,
MultiOne will make a sound when a feature configuration is (un)successfully
read from a driver.

¢ Prevent sleep mode. By checking this check box MultiOne will prevent the PC
or laptop from automatically entering the sleep mode as long as MultiOne is
active.

o Write & verify. By default, MultiOne will write parameters to the connected
device(s) without checking the state of the device afterwards. By enabling
Write & verify you force MultiOne to perform an additional verification step
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by reading back the written parameters immediately after writing. If the
received values differ from the parameters that were written, MultiOne will
alert you that there is a deviation between MultiOne and the device.

The Write & verify uses different status icons then Write. When a Write &
verify action is successful the icon will be totally green . When the verify
action has failed the entire icon will become red. ¥ A pending action will be
displayed is a grey icon. ¥ ™ It is also possible that a part of the Write &
verify fails. To help indicate where the action failed, two extra icons exist. If the
first half of the icon is red and the second part is grey, B% then the write
action failed. When the first part is green and the second part is red, L then
the read action has failed.

Show connection settings. Changing this setting allows you to control the
appearance of Connection Settings window when MultiOne starts. The
following options are possible:

Only when no interface connected: Connection Settings window will be
shown on startup only when there are no interfaces connected.

Always on startup: Connection Settings window will always be shown on
startup.

Never on startup: Connection Settings window will never be shown on
startup.

Re-enable all warnings. MultiOne produces a number of warnings that you
can disable by checking their Don’t show this message again check box. If
you would like to reset all suppressed warnings click the Re-enable all
warnings button.
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12.18.2 DALI scanning
e . @

DALI scanning preferences

General DALI scan method [E\y short address
DALI scanning

Scanning by shaort address does not change the random address of any
Updates device in the network. Choose this option if randem addresses
shouldn't be affected.

e DALI scan method. Changing this setting allows the user to control the way in
which a DALI network is scanned. The following options are possible:
By short address: DALI devices are scanned by their short address.
By random address: DALI devices are scanned by their random address.

For more details on the DALI scan methods, see Identifying devices.

12.18.3 Updates
e . o

Updates preferences

General MultiOne updates® [Automatic - Check only

DY LHE S EThiy Automatically check for updates; notify when an update is available

Updates

* Takes effect once MultiOne is restarted
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e MultiOne updates. Changing this setting allows the user to control the
update method of MultiOne. The following options are possible:
Automatic — Check, download, install: MultiOne will automatically check for
updates and if available download and install them automatically.
Automatic — Check, download only: MultiOne will automatically check for
updates and if available download them. The user then has to agree to let
MultiOne update itself.
Automatic - Check only: MultiOne will automatically check for updates and
notify the user if a new version is available. The user can then allow MultiOne
to download and install the update.
Manual: MultiOne will do nothing and the user has to force MultiOne to
check, download and install any update.

12.19 Manually selecting the USB2DALI interface

MultiOne will automatically detect the USB2DALI interface that is connected to the
PC. However when multiple interfaces are connected it will use the interface on the
port that is found first. It is possible to manually change the port that is used by
selecting Tools = Connection settings.

Preferences...

LConnection settings...

Pawer supply 3
[

In the pop-up window it is then possible to select the desired port.

Connection settings @
® DALI ZigBee Art-Met SimpleSet
Interface selection
Selected interface MuttiOne DALl interface -
Selected port 17A717294007 -
|

Notice! The unique id of the interface is shown at the port selection. This, to be able
to identify which interface is used by which MultiOne instance (when configuring
devices in parallel using multiple instances of MultiOne).
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12.20 Enabling/Disabling the power supply of the USB2DALI interface

The USB2DALI interface will automatically detect if the DALI bus is powered by
another device (for example a DALI power supply). If the DALI network is not
powered, it will use its internal power supply.

Tools

Preferences...

Connection settings...
LI\ Power supply 3 |

Enable power supply

| Disable power supply

If, during operation, the DALI network is changed in a way that it requires the
USB2DALI interface to switch on or off its internal power supply, you can do so using
the option Tools = Power supply.

12.21 Supported features

The table below gives an overview of all features that are supported by MultiOne and
to which product groups they apply.

Table 4 Supported features

Device feature Product group
LED HID FLUO CONTROL
Indoor Outdoor
1-10V X

ActiLume General
ActiLume Mode

ActiLume Scene X
Active Cooling X

Adjustable Light X

Output

Adjustable Output X X

Current

Adjustable Startup X

Time

AmpDim

Constant Light Output
Correlated Color
Temperature

Corridor Mode X X
DALI Power Supply
Device Info
Dimming Interface
Driver addressing
Dynadimmer

X X X X
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DC Emergency X
End Of Life indication X

Energy Meter X
Lamp Burn-in

Lamp Selection X
Light Source Operating X

Hours

LineSwitch X X
Lumen Level X

LumiStep

Min Dim Level

Module Temperature X X
Protection

OEM Write Protection X X

Quick Lamp Start

Summary X X X
Touch and Dim

12.22 Device-specific technical descriptions

For a detailed technical description of the characteristics of the devices, please visit
the product-specific Philips web sites:

Table 5 Product-specific Philips web sites

Product group Visit:

LED www.philips.com/Xitanium

HID www.philips.com/Xtreme

FLUO www.philips.com/HFR-Intelligent
CONTROL www.philips.com/Actilume

12.23 Error handling
12.23.1 Reporting and correction of errors/warnings when reading from a

feature configuration file
When, after opening a feature configuration file, incorrect parameters are detected,
MultiOne tries to correct these parameters for the selected (virtual) device. When a
correction is made, a red border will be shown. In cases when no logical correction
can be made, an orange border will be shown.

12.23.2 Reporting of errors when reading from a device
When after reading from a device a mismatch is signaled between the parameters of
the device and MultiOne, MultiOne will not correct the parameters, but will show a
red border.
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12.23.3 Reporting of errors when entering incorrect values in a feature
Entering an incorrect value for a parameter will be indicated by a red border.

12.24 Troubleshooting

Problem: After starting MultiOne, no devices are displayed.

Solution: Click the Scan network button on the Network panel to start discovering
the devices in the network. If the devices connected have already a DALI short
address this will not be changed. Devices without a short address will be
programmed with a short address. When the Commission button is clicked, the short
addresses of all connected devices will be renewed, whether they already had a short
address or not.

Problem: I would like to assign a specific short address to a device.
Solution: First scan the network for devices. Right-click the device you would like to
give a short address and select Set short address.

=8 All devices

M () itanium 17W 0.3-1£24U Th/e 93040

‘... User-defined groups Identify
Add to user-defined group  »

Lk Set short address... |

Reset short address

A dialog window will appear in which you can enter the desired short address.

Custom short address &]

Short address ) B

[ ok [ cancel |

Click OK to program the short address into the device.

Problem: I would like to remove the short address of a device.
Solution: First scan the network for devices. Right-click the device whose short
address you would like to remove and select Reset short address.

[=)- All devices

R () itanium 17W 0.3 ;

‘... User-defined groups Identify
Add to user-defined group  »
Set short address...

L\ Reset short address |

You will be informed that the short address was reset.
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Short address reset @

The short address has been reset to 255.

Problem: I would like to configure the special features of the connected device.
Solution: After scanning the network for devices, a device has to be selected by
clicking it in the Network. Select the Device features tab. The related features will
appear. To update the view to the actual status of the features, click Read on the
toolbar. If you now change any of the features, and want this to be stored into the
device, click Write on the toolbar.

File  Actions View Tools Help

‘of\‘ead @ wiite + B Reset |-' -

Problem: I would like to know more technical details of a device.
Solution: Please refer to the Philips website for more detailed information
e For LED driver, both indoor and outdoor, visit: www.philips.com/Xitanium
e For HID drivers visit: www.philips.com/Xtreme
e For FLUO drivers visit: www.philips.com/HFR-Intelligent
e For controls visit: www.philips.com/Actilume
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13 Keyboard shortcuts

Keyboard shortcuts can make it easier to work with MultiOne without using the

mouse.

Table 6 Keyboard shortcuts

USB2DALI interface

USB2ZigBee interface

The File menu
Ctrl+O

Ctrl+S

Ctrl+Shift+S

Alt+F4

The Action menu
Ctrl+D

Ctrl+Q

Ctrl+R

Ctrl+W

The Tools menu
Ctrl+M

The Help menu
Shift+F1

F1

Working with feature configuration files

Open a feature configuration
file

Save a feature configuration
file (Save)

Save a feature configuration
file

(Save As)

Not supported
Not supported

Not supported

Exit MultiOne
Working with devices

Scan network
Commission

Read from current device
Write to current device

Scan area

Not supported
Not supported
Not supported

Open the Application mode selector

Open the Getting started document
Open the User manual
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14 Software Update

MultiOne has the possibility to update itself to a newer version. This can be done
either automatically or manually and can be set in the preference window, see the
Setting Preferences for more info.

Preferences @

® Show application mode selector on startup™®
O Scan network autormatically on startup®
[0 Write & wverify

When write & verify i= enabled an additional verification step will be
carried out after writing a feature configuration to a device.

MultiOne updates® [Mmaﬁc—[hedcmiy ']
Automatic - Check, download, install

Automatically check g o check download on is available
Automatic - Check onl
Manual k

Re-enable all warnihgs
| * Takes effect once MultiOne is restarted m

If the preference is set to Manual then the user can check for an update on MultiOne
by selecting Help > Check for updates option.

Lb Check for updates
@
a

Supported devices...

Getting started... Shift+F1

User manual... F1

About...

After a manual update check, or by using the automatic options, the update status
near the Help menu will show if a new version is available. The user can then decide
to continue downloading/updating by either using the update status or the Help
menu to carry on.

Download and Update now
S

upported devices...

@ Getting started...  Shift+F1
@ User manual... F1

# Update is ready to be installed.
Download and Update now

About... . View changes in version 2.6.0 2

After downloading the update status will inform the user to restart to continue.

Help () Update wil be installed on next start.

Restarting MultiOne will install the update.
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e - ——

Downloading & Installing updates
Updating Philips MultiOne Expert Release to the latest version.

wylpdate is downloading and installing updates for Philips MultiOne Expert Release.
This process could take a few minutes.

v Downloading update
Backing up and updating files
Backing up and updating registry

") Optimizing and executing files

A successful update of MultiOne will be shown in the update status.

sfully updated to
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15 Copyright

Copyright © 2014 by Philips Lighting B.V.

All rights reserved. No part of this publication may be reproduced, transmitted,
transcribed, stored in a retrieval system or translated into any language or computer
language, in any form or by any means, electronic, mechanical, magnetic, optical,
chemical, manual or otherwise, without prior written permission from Philips. Brands
and product names are trademarks or registered trademarks of their respective
companies.
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16 Disclaimer

Philips makes no warranty of any kind with regard to this material, including, but not
limited to, the implied warranties of merchantability and fitness for a particular
purpose.

Philips assumes no responsibility for any error that may appear in this document.
Philips makes no commitment to update nor to keep current the information
contained in this document.
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17 Limitations of damages

The vendor will not be liable for any indirect, special, incidental or consequential
damages (including damages for loss of business, loss of profits, or the like), whether
based on breach of contract, tort (including negligence), product liability or
otherwise, even if the vendor or its representatives have been advised of the
possibility of such damages and even if a remedy set forth herein is found to have

failed its essential purpose.
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